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How to Submit a GT Special Meal Form
Procedure
In this topic you will learn How to Submit a GT Special Meal Form.
Step Action
1. To streamline and automate special meals prior approval form, an electronic version

of the previously paper-based form has been developed. This e-form will allow
greater ease of use, more visibility into the whereabouts of the form, and electronic
workflow approvals.

2. NOTE: To access the special meals eform in PeopleSoft, an employee will need
security access assigned to their user profile. Please check with your departmental
Business Manager and/or the Accounts Payable Team for more information
regarding gaining access.

Roles and workflow assigned for Special Meals Forms:

1. Form Requestor (A REQUESTOR CANNOT APPROVE HIS/HER OWN
FORM)

2. Department level approval

3. Dean’s office approval

3. Must Dos:

* Please be sure to enter information into all required data fields.

» Attach a list of attendees with specific names and affiliation to the University is
required.

* Click SUBMIT; the eform will then enter the approval workflow designated by
your School/Administrative section.
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- Homepage x  +

c 23 rcbb.psfs.lsuhscedu/psc/fsupg/EMPLOYEE/ERP/c/NUI_FRAMEWORK PT_LANDINGPAGE.GBL

[0 Other [ PeopleScftinfo [ PeopleAdmin

& Ado obat PeopleSoft Web Lau..

Menu « Search in Menu

My Financials Home v

System Notifications

PS9FSUPG Notice: This system is
configured for GT eForm testing
Contact the support team with
questions
This is a test instance for LSU
Health PS Financials. Last refresh
date: 2025-02-19

LSU Speedtype Lookup

ORACLE
PEOPLESOFT

=! Q Search

Step Action

4. Click the button to the right of the My Financials Home field.

b

5. Press the left mouse button and drag the mouse down the list.
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PeopleSoft Web Lau...

Menu « Search in Menu

My Financials Home v
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Asset Management
Projects & Receivables
General Ledger
Procurement

GT eForms™ Homepage

B LSU Speedtype Lookup
stem is

sting

with OoRACLE

LSU PEOPLESOFT

fefresh

[ ||
B

Q Search

o
& 4/10/2025

Action

Click the GT

eForms Homepage link.

GT eForms™ Homepage

Click the NO

AP Special Meal Form button.
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Form Family Landing Page X  +

] 2% rcbb.psfslsuhscedu/psc/fsupg/EMPLOYEE/ERP/c/NUI_FRAMEWORK PT_AGSTARTPAGE_NULGBL?CONTEXTID...

[3 Other [ PeopleSoftinfo [J PeopleAdmin Solutions A~ Ac bat PeopleSoft Web Lau...

.

< GT eForms™ Homepage Spcl Meals&Entertainment Resi3tinancials UPG Rt QA 4 ¢

7| Landing Page Welcome to LSUHSC-NO Request for Special Meals and Entertainment eForm

% Add a LSUNO spcl MAE eForm

| Evaluate a SMAE Form eForm

5] Update a SMAE Form eForm

5] View a spcl MAE eForm

oy

=! Q Search

*  4510/2025

Step Action

8. Click the Add a LSUNO spcl MAE eForm button.

+| Add a LSUNO spcl MAE eForm
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= cForm (Fluid)

£ GT eForms™ Homepage Spcl Meals&Entertainment Resi3tinancials UPG @ QA 4

aalt

a
4+ ) Add SMAE Request : request special meal Form ID 11457 (NEW)

Highlights Enabled: Yes J Current Values ( K—| [ =

NEW ORLEANS
Request for Prior Approval of Special Meal

D Breakfast $18.00
Lunch $26.00

Dinner $45.00

Refreshment $5.50

Reception $8.00

*amounts are maximum allowable

Event Information

,.- Q Search = X ] -;‘_

Step

Action

The Form ID and Status are displayed in the top right corner of the page. In this
example, the Form ID is 11457 with a Status of (NEW).

NOTE: If you save the form rather than submitting it, the Form ID and Status
will be useful when searching for the form.

Press the left mouse button and drag the mouse down to the desired location.
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£ GT eForms™ Homepage

Event Information

Business Unit LSUNO

“DEPTID Q Department |
RequestDate 04/10/2025 *Event Date | 04/10/2025 ‘
Contact Information
D Requestor Name y Contact Name (Form
(Form Entered By) KOCONN  &'Connor, Karen Requested For) ‘ ‘
Requestor Phone  225/202-9461 Contact Phone ‘ ‘
Requestor Email koconn@lsuhsc.edu “Contact Email ‘ ‘

Event Details

How will LSUHSC pay for this Expense?

4

[ [ | ks . 1 a i
B Q Search = ] L7 = R

Step Action

10. Enter the desired information into the DEPTID field. Enter "1673200".
NOTE: The Department Name will be displayed when you navigate away from the
DEPTID field.

11. Users may click the calendar to search for the *Event Date or enter it directly into

the *Event Date field.

Click the Calendar button to choose the desired date.

12. Click the 23rd for the *Event Date.
23
13. Enter the desired information into the Contact Name (For Requested For) field.
Enter "Talesia Williams".
14, Enter the desired information into the Contact Phone field. Enter "225-354-4860".
15. Enter the desired information into the *Contact Email field. Enter
"twilll@Isuhsc.edu™.
16. Press the left mouse button and drag the mouse down to the desired location.
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ULGBL?CONTEXTID... ¥¢

< GT eForms™ Homepage Spcl Meals&Entertainment Rezi3tinancials UPG fn Q

al

Event Details

How will LSUHSC pay for this Expense?

*Payment Type ~

Self-Funded event
(Continuing
education, student | No
activity funding

D sources)

*Justification- Why
is this event
scheduled?

On-Campus © Yes ([ ) Off-Campus ( No
_ - -

Location Address

“Fuant Titla | M | v

— = . ~ " 435 PM
Br Q Search =. m LS - ] 4710/2025

Step Action

17. Click the button to the right of the *Payment Type field.
18. Click the Direct Pay reimbursement list item.

Direct Pay reimbursement

19. Enter the desired information into the *Justification - Why is this event
scheduled? field. Enter "Training Team FY 2026 Planning Meeting".
20. Change the event from being On-Campus to Off-Campus.

Click the Off-Campus option.

1
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NULGBL?CONTEXTID...

£ GT eForms™ Homepage Spcl Meals&Entertainment Resiatinancials UPG @ QA 4

Event Details

How will LSUHSC pay for this Expense?

“Payment Type | Direct Pay reimburseme v

Self-Funded event
(Continuing
education, student | No
activity funding

D sources)

*Justification- Why
is this event
scheduled?

Training Team FY 2026 Planning Meeting

On-Campus {_ No Off-Campus ( Yes Q

*Location Address

“Fuant Titla | M | v

=! Q Search

Step Action

21. Press the left mouse button and drag the mouse down to the desired location.

22. Enter the desired information into the *Location Address field. Enter "Piccadilly
Cafeteria".

23. Enter the desired information into the *Location Address field. Enter "5179 Plank
Rd".

24. Enter the desired information into the *Location Address field. Enter "Baton
Rouge, LA 70805-3559".

25.

Click the button to the right of the *Event Title field.

W
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] 2% rcbb.psfslsuhscedu/p upg/EMPLOYEE/ERP, JI_FRAMEWORK.PT_AGS

[0 Other [ PeopleScftinfo [ PeopleAdmin Soluti Ad PeopleSoft )

< My Financials Home LSUNO SMAE wean Financials UPG Ay Q [:L
— —_—— O
On-Campus | No ) Off-Campus \/ Yes | /\
Piccadilly Cafeteria
. ) 5179 Plank Rd
Location Address | Baton Rouge, LA 70805-3559
)
Event Title ‘% *Describe purpose of
e
Faculty Interview e p
Resident Interview
D Type of Meal Post Doc Interview
Agency Hosted Conference
Summer Program Event
“Type of Request | Student Event LSUHSC
Student Interview
University Guest/Speaker Event
Attendee Count & To - .
Qrientation
Training Event
“Number of | Grand Rounds(no-LSUHSC spkrs)
Attendees Other
“Per Person Cost ‘1.00 o

117 PM

: & d B,
: g 7 ) ,
Q Search |4 g g 4/16/2025

Step

Action

26.

Click the Other list item.
Other

217.

Enter the desired information into the field. Enter "Developing training plan for
FY 2026".

28.

Click the button to the right of the *Type of Request field.

W

Page 9



Training Guide
eForm

= cForm (Fluid)

£ My Financials Home:

On-Campus | No ) Off-Campus \/ Yes /\

Piccadilly Cafeteria
5179 Plank Rd

“Location Address | Baton Rouge, LA 70805-3559

* Other i ini
Event Title ‘ Other ~ “Describe purpose of Developing training plans for FY 2026
the event and meal
type
)
D Type of Meal
“Type of Request ‘ V‘
Attendee Count & To| Blanket Approval il

One Time Event

"r:umbelr of ‘1—‘

“Per Person Cost ‘1.00 ‘

’,. Q Search

Step Action
29. Click the One Time Event list item.
One Time Event
30. Press the left mouse button and drag the mouse down to the desired location.
31. Click the button to the right of the Meal Type field.

W
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£ GT eForms™ Homepage Spcl Meals&Entertainment Resiatinancials UPG @ QA 4

al

Type of Meal

*Type of Request ‘ One Time Event V‘

Conference Breakfast
Description | Refreshments

Lunch &2

Reception
Attendee Count & To{ Dinner sal

“Number of 1
Attendees

Per Person Cost 1.00

Total Cost of the

Meal 000

Attendee Affiliation
*Select All That Apply *

,.- Q Search

Step Action
32. Click the Lunch list item.
Lunch
33. Enter the desired information into the *Number of Attendees field. Enter "3".
34. Press the left mouse button and drag the mouse down to the desired location.
35. Click the Employee option to turn it to Yes.
No
36. Press the left mouse button and drag the mouse down to the desired location.
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(] 23 rcbb.psfs.lsuhscedu/ps upg/EMPLOYEE/ERP, JI_FRAMEWORK.PT_AGS
[3J Other [J PecpleSoftinfo [ PeopleAdmin Soluti Ad: PecpleSoft |
< GT eForms™ Homepage LSUNO SMAE weatn FiNancials UPG Q Q [:L
Tag ACCOUNT FUND

Accounting Tag © Description “ACCOUNT DESCRIPTION Percent ¢ DECT copE PROCR
1 Q v 100.00
File Attachments

1 row
Attachment Required Upload Description < Description & File Name < Delete

D 1

Add

» Comments

o Upload Attendee List/Guest List Attendee List/Guest List Delete

9:27 AM

[ = o) e
& )
Q, Search 1 ] 4/16/2025

Step

Action

37.

Enter the desired information into the Accounting Tag field. Enter "0673200001".
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= eForm (Fluid) X ar
c 23 rcbb.psfs.lsuhscedu/p / E/ERP/c/NUI_FRAMEWORK.PT_AC TPAGE_NULGI
[3J Other [J PecpleSoftinfo [ PeopleAdmin S sat PecpleSoft Web Lau... vy SB TeamDyn
< GT eForms™ Homepage LSUNO SMAE weatn FiNaNcials UPG Q Q [:l
ACCOUNT
Accounting Tag & Tag Description < “ACCOUNT & DESCRIPTION Percent <
1 |0673200001 Q.| 488160511 PEOPLESOFT-ADM SUPP | v‘ 100.00
543700
File Attachments 565300
565310 1 row
D Attachment Required Upload Description & Description = File Name < Delete
! ] Upload | Aftendee ListGuestList | Attendee List/Guest List Delete

Add

» Comments

Step Action

38. Click the Account list item.
543700

39. Press the left mouse button and drag the mouse to the right side of the page.
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£ GT eForms™ Homepage

ACCOUNT FUND
DESCRIPTION Percent & DEF1  cope PROGRAM CLASS ppgecrt o BUIRCRACT
v| Food Suppiies 100.00| 1673200 111 54000 10105 a| tsuno |+‘ ‘—|

1 row

n File Name < Delete
| Delete

st

Step

Action

40.

View the chartstring for the specified Accounting Tag.

Press the left mouse button and drag the mouse to the left side of the page.
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G % rcbb.psfslsuhscedu/psc/fsupg/EMPLOYEE/ERP,

[3J Other [J PecpleSoftinfo [ PeopleAdmin Soluti
< GT eForms™ Homepage LSUNO SMAE weatn FiNancials UPG Q Q [:L
ACCOUNT
Accounting Tag © Tag Description < “ACCOUNT < DESCRIPTION Percent <
1 | 0673200001 Q,| 488160511 PEOPLESOFT-ADM SUPP | 543700 w| Food Supplies 100.00
File Attachments
1 row
D Attachment Required Upload Description < Description & File Name < Delete
1 o Upload Attendee List/Guest List Attendee List/Guest List Delete
Add
» Comments

9:29 AM

[ = o) tm
& )
Q Search 1 ] 4/16/2025

Step

Action

41.

You will search for a file to attach on the Desktop called TT Luncheon Attendees.
Click the Upload button.

Upload

Page 15



Training Guide
eForm

= cForm (Fluid)
c 23 rcbb.ps
[3J Other [J Peaples

< GT eForms™ Homepage

LSUNO SMAE

PeopleScft Web Law.. W SB TeamDyna

v Financials UPG @

ACCOUNT.

Accounting

"

File Attachment

1 |0673200001% Choose From

File Attachment I:|D

My Device

Add '

» Comments

D Amchment} '
1 o LTI

BB Q Search

Percent <

100.00

1 row

Delete

Delete

Step Action

42. Click the My Device button.

43. The file name you are looking for is TT Luncheon Attendees.

Press the left mouse button and drag the mouse to the right side of the page.
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+ 4 B> Karen-LSUHSC > Desktop

Qrganize v New folder

> Karen - LSUHSC -

B Desktop

Percent <

B Documents
100.00

X Pictures
o TT Luncheon Attendees

1 row

[ Delete

elete
Com 9 [ ooe

» Comments

javascriptdecumentgetElemen rigFileName’).clic...

11:06 AM

C I | e ] :‘ R W ~ = D e 4/16/2025

’.. Q Search

Guide
eForm

Step

Action

44,

Click the TT Luncheon Attendees link.

WE TT Luncheon Attendees

45.

Click the Open button.

Open |v
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[ Other JleSoftinfo [ PeopleAdmin

< GT eForms™ Homepage

Solutions PeopleSoft Web Lau.. W SB TeamDyn

LSUNO SMAE _, Financials UPG @

ACCOUNT.

Accounting

i

File Attachment X

1 |0673200001% Choose From

File Attachment

Amchment] .
D

Add File Size: 13KB

» Comments

10 e

TT Luncheon Attendees.docx

Percent <

100.00

Delete

Delete

11:07 AM
4/16/2025

Step

Action

46.

Click the Upload button.

Upload

47.

Click the Done button.
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cForm (Fluid) X  +

G % rcbb.psfslsuhscedu/psc/fsupg/EMPLOYEE/ERP,

[3J Other [J PecpleSoftinfo [ PeopleAdmin Soluti
< GT eForms™ Homepage LSUNO SMAE weatn FiNancials UPG Q Q [:L
ACCOUNT
Accounting Tag Tag Description < “ACCOUNT < DESCRIPTION Percent <
1 | 0673200001 Q,| 488160511 PEOPLESOFT-ADM SUPP | 543700 w| Food Supplies 100.00
File Attachments
1 row
Attachment Uploaded View Description < Description & File Name < Replace
1 0 View Attendee List/Guest List | Attendee List/Guest List TT_Luncheon_Attendees.docx
Add
» Comments

Q Search

Step

Action

48.

Verify the list details attendees' specific names and affiliation to the University.

Click the View button to view list of attendees.

View
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cForm (Fluid)

c

rcbb.ps

[ Other
£ GT eForms™ Homepage
Accounting Tag

1 |0673200001

File Attachments

D Attachment Uploaded

'@

» Comments

[ PeopleSoft Info

upg/EMPLO ERP/c/NUI_FRAMEWORK.PT_A(

O PeopleAdmin Solutions & Adobe Acrobat

LSUNO SMAE

Tag Description & “ACCOUNT <

Q| 488160511 PEOPLESOFT-ADM SUPP | 543700

View Description < Description &

Attendee List/Guest List | Attendee List/Guest List

’AGE_NUI.GBL?

PeopleSoft Web Lau... vy S

wnFinancials UPG @ Q. 4

ACCOUNT
DESCRIPTION Percent <
| Food Supplies 100.00
1 row
File Name < Replace

TT_Luncheon_Attendees.docx

Step Action

49.

Click the Downloads button.
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cForm (Fluid)

c 23 rcbb.psf:

r [3 PeopleSoftinfo [ PeopleAdmin

< GT eForms™ Homepage LSUNO SMAE

Training_Team_Luncheon_Attendees
"ACCOUNT & (1).docx

2 hours ago

Accounting Tag & Tag Description &

Training_Team_Luncheon_Attendees.doc
x

1 |0673200001 Q. | 488160511 PEOPLESOFT-ADM SUPP | 543700

Tours age

Full download history

File Attachments

1 row

Replace
1 0 Attendee List/Guest List | Attendee List/Guest List TT_Luncheon_Attendees.docx

» Comments

D Attachment Uploaded View Description < Description & File Name <

Q Search

o & 1112 AM
L B

Step Action

50. Select the appropriate file from the download list.

Click the TT_Luncheon_Attendees Open button.
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w | “) - ) %  TT_luncheon_Attendees - Protected View » Saved to this PC pel = a *
File Home Insert Draw Design Layout References Mailings Review View Help RefWorks - RCM  Acrobat |E\ %
@ PROTECTED VIEW This file is being verified by Microsaft Defender Advanced Threat Protection. You can continue to read thi
Viewing a
You can only view this document. You do not have
permissions to edit it.
[[raining Team Luncheon Attendees
Talesia Williams Staff Director of PeopleSoft Training
Karen O'Connor Staff PeopleSoft Training Coordinator
‘Wanda Dooley Staff PeopleSoft Training Coordinator
v
Page 1of 1 23 words T Focus B - —F——+ 100%

Step

Action

ol.

If you receive this message, simply click the OK button to close the popup.

Click the OK button.

52.

If the list needs to be edited, click the Enable Editing button on your Browser.

Click the Close button.
4

53.

Click the Submit button.
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£ GT eForms™ Homepage

4+ ) Add SMAE Request : Result

You have successfully submitted your eForm.
The eForm has been routed to the next approval step.

multiple approvers.

View Approval Route (Add Ad Hoc Approver)

D Transaction / Signature Log

Current Date Time Step Title User ID Description Form Action

1 04/16/2025 9:33:33AM

Refresh Log

Initiated KOCONN O'Connor, Karen Submit

Training Guide
eForm

Form ID 11462 (Pending)

1 row

Time Elapsed

9:35 AM

4/16/2025

Step

Action

54.

and routed for approval.

the View a LSUNO SMAE eForm option on the Landing

Once submitted, the eForm will enter the electronic workflow approval process. The
requester will receive confirmation stating the form has successfully been submitted

NOTE: Users will be able to access the View Approval Routes panel when using

Page.

55.

To determine where your form has been routed for approval:

click the View Approval Route button.

View Approval Route (Add Ad Hoc Approver)

Click the View Approval Route (Add Ad Hoc Approver) button.
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= View Approval Route
c 23 rcbb.p

[0 Other [ PeopleSoft Info

e et | Cancel View Approval Route

(+/'3 Ad Review/Edit Approvers (Pending)
Basic Stage

You havl +G3FORM_ID=11462 Pending

The eFo Start New Path

multiple Basic Path

Z Pending EY NotRouted
»
Multiple Approvers Multiple Approvers
[ View A ZZAP_SPECMAE_DEPTAPPR> | ¥ | ZzAP_sPeCMAE._FIscALDEANS

D Transacti 1 row
Cui %ed
1

1 o4

[ Refresh

Print

[ | ] = 72 = 2:35 AM
. Q, Search - < g 4/16/2025

Step Action

56. This panel shows that the form has been routed to the first Approver and has a Status

of Pending. It also shows that the form has not been routed to the second Approver
and it has a Status of Not Routed.

Click the Done button.

57. Users may print a copy of the submitted form.

Click the Print button.

Print
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c 2% rcbb.psfslsuhscedu/psc/fsupg/EMPLOYEE/ERP/c/NUI_FRAMEWORK PT_AGSTARTPAGE_MULGBL?CONT...

[3 Other [ PeopleScftinfo [ PeopleAdmin PeopleSoft Web Lau... W SBTeam

Training Guide
eForm

x4

Dyna

< GT eForms™ Homepage LSUNO SMAE wan Financials UPG Q Q [:L

1_\+:3 Add SMAE Request : Result

You have successfully submitted your eForm.
The eForm has been routed to the next approval step.

multiple approvers.

Print Selection [ |
[ View Approval Route (Add Ad Hoc Approver) Report |
Name
D Transaction / Signature Log
rint
Current Date Time Step ;
1 04/16/2025 9:33:33AM Initiated — KOCONN O'Connor, Karen Submit

Refresh Log

Form Action

Form ID 11462 (Pending)

Time Elapsed

9:34 AM

& Oy

*  4716/2025

Step

Action

58.

Click the button to the right of the Report Name field.

W

59.

Click the ZZAPSPCLMEAL list item.
ZZAPSPCLMEAL

60.

Click the Print button.

Print

Page 25



Training Guide
eForm

= eForm (Fluid) X & ZZAPSPCLMEALpdf

c £3 Adobe Acrobat: PDF edit, convert, sign tools  chr, faidnbmnnnibpcajpc: findmkaj/htt

[3 Other [ PeopleScftinfo [ PeopleAdmin Solutions Adobe Acrobat PeopleSoft Web Lau... Wy SB TeamDy

Alltools  Edit  Convert  E-Sigy v =

Louisiana State University Health Sciences Center
AP Special Meal and Entertainment Request
Form ID: 11462

From Department:  PeopleSoh Support Org Request Date:  2025.04-16
Department ID: Requester. KOCONN

Event Date_| Function Location Off Campus_ | On Campus,

Apr23, 2025 | PICCADILLY CAFETERIA Y N

5179 PLANK RD

BATON ROUGE. LA 70805-
Tustication | Training Team FY 2026 Planning Maeting

EventTitle | OTH | Other ~ Developing Lraining plans for FY 2026

Requested Talasia Wiliams Contact twill1@lsuhsc.edu
for: Email

Total Cost | Per Guest Cost | Meal Type Number of Guests

$75.00 25.00 L 3

Speediype | Account Dept Frogram | Class | Project Percent

543700 1673200 54000 10105 100

Q Search

Step Action

61. Users will click the Printer icon to print the form request.

NOTE: This form, along with the list of attendees, must be printed and included
with LaCarte or Direct Pay documentation.

Click the Close tab button.
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o7 “0 00 T L s *THISIS A TEST GT EFORM * Form SPCLMEAL - Your SMAE Request eForm 11462 is Approved - Message (.. pel = a *
File Message ﬂ Acrobat
® Help ﬂ Contact Support E Troubleshoot ,ﬁ!\_v] Feedback é Suggest a Feature &5 Show Training éﬁ{ What's New
*THIS IS ATEST GT EFORM * Form SPCLMEAL - Your SMAE Request eFarm 11462 is Approved
“ S
PS Financials Development |© | ) Reply | D Reply Al ‘ — Forward ‘ ‘ i ‘ ‘_|
To © O'Connor, Karen B. Wed 4/16/2025 4:32 PM
®Vuu replied to this message on 4/16/2025 4:35 PM.
THIS IS ATEST GT EFORM.
Your IT eForm 11462 is approved by Keegan, John.
Request Date: 2025-04-16
Comments:
You can review the form from this link: https://rcbb.psfs.lsuhsc.edu/psp/fsupg/EMPLOYEE/ERP/c/G3FRAME.G3SEARCH FL.GBL?
Page=G3SEARCH FL&Action=U&G3FORM ID=11462&G3FORM TASK=VWS
’r. Q Search
Step Action
62. Once the form has been approved, the requester will receive the email shown here.

NOTE: Select the hyperlink to retrieve the form.

63. Click the Home button.
&
i
64. This completes How to Submit a GT Special Meal Form.

End of Procedure.
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